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Leine & Linde AB claims copyright on this documentation. This documentation may not be 
modified, extended or passed onto to a third party and/or copied without written approval 
from Leine & Linde AB.  
 
Specifications and content in this document are subject to change without prior notice 
due to our continuous efforts to improve the functionality and performance of our 
products. 

1. Introduction 
Thank you for choosing this device produced by the Swedish encoder manufacturer Leine 

& Linde. In your hands, you have a state of art component that is ready to be used in the 
outmost demanding environment. This absolute encoder equipped with PROFINET 
interface, enables you to design high performance automation systems.  
 
This manual describes the installation procedures and configuration of an absolute 
encoder with PROFINET interface. If you are in need of assistance during the system 
design phase, commissioning or during operation, please make sure that you contact your 
local Leine & Linde representative. 

1.1 Applicability of manual 
This product manual is applicable to the absolute encoder versions equipped with 
PROFINET interface within the following encoder series: 
 
 RSA 607 RHA 607 
 RSA 608 RHA 608 
 
Leine & Linde is a company that often customizes the product to fit individual 
requirements of our customers. Such customized products may therefore not be fully 
compliant with the descriptions in this product manual. Customized encoder devices are 
indicated by their type label, and marked 69X where the “9” digit in the second position 
indicates that the device has some customized parameters. Encoder series with the 
following name and type plate information may therefore have deviating functional 
performance. 
 
 RSA 697 RHA 697 
 RSA 698 RHA 698 
  
If your product is of the type mentioned above, contact Leine & Linde to obtain the 
product’s complete functional description. 

1.2 About Leine & Linde  
For more than 40 years, the Swedish based company Leine & Linde has concentrated on 
one thing – development and manufacturing of advanced encoders that meet the most 
rigorous demands a user can place on them. That is why a wide assortment of 
incremental and absolute encoders with obvious concentration on robust products and 
quality down to the last detail can be offered. Leine & Lindes encoders provide the utmost 
in reliability year after year, in working conditions where vibration, dirt, cold and other 
harsh environments are common.  
 
Leine & Linde can meet very specific individual demands. Due to a modular design in the 
collection, the encoders are easily adapted exactly to the customer’s needs with respect to 
resolution, electrical connections and interfaces, voltage, casings, etc. That is due to the 
fact that tomorrow’s technology is already being used today in Leine & Linde products. 
Leine & Linde concentrates on advanced development of intelligent encoders with 
integrated ASICs, new special features and with adaptations to different field bus systems. 
This enables us to meet the need for increasingly effective and dependable machines and 
automation to an even higher degree. 
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1.3 About absolute encoders 
With an absolute encoder, each angular position is assigned a coded position value. This is 
generated by a code disc equipped with several parallel fine graduations tracks which are 
scanned individually. On single turn encoders, i.e. an encoder producing absolute 
positions within one revolution, the absolute position information repeats itself with every 
revolution. So called multi-turn encoders can also distinguish between revolutions. The 
numbers of unique revolutions is determined by the resolution of the multi-turn scanning 
and repeats itself once the total resolution is reached. A benefit of the absolute encoder 
type is that if the encoder loses power, the encoder is also able to keep track of its position 
if the shaft is turned during the power loss. This is due to the genuine absolute scanning 
principle.  
 
An absolute encoder can also be used to calculate a digital speed value. By internally 
dividing the difference in position by a small delta time, an accurate speed value can be 
calculated and transmitted to the subsequent electronics for closed loop control.  

1.4 About PROFINET technology 
PROFINET is the open industrial Ethernet standard of PROFIBUS & PROFINET International 
(PI) for automation. PROFINET uses TCP/IP and IT standards, and is in effect, real-time 
Ethernet. The PROFINET concept features a modular structure so that users can select the 
cascading functions themselves. They differ essentially because of the type of data 
exchange in order to fulfill the very high speed requirements. 
 
In conjunction with PROFINET, the two perspectives PROFINET CBA and PROFINET IO 
exist. PROFINET CBA is suitable for the component-based communication via TCP/IP and 
the real-time communication for real-time requirements in modular systems engineering. 
Both communication options can be used in parallel. 
 
PROFINET IO was developed for real-time (RT) and isochronous real-time (IRT) 
communication with the decentralized periphery. The designations RT and IRT merely 
describe the real-time properties for the communication within PROFINET IO. 
 
To achieve these functions, three different protocol levels are defined: 

• TCP/IP for PROFINET CBA and the commissioning of a plant with reaction times in 
the range of 100ms  

• RT (Real-Time) protocol for PROFINET CBA and PROFINET IO applications up to 1 
ms cycle times  

• IRT (Isochronous Real-Time) for PROFINET IO applications in drive systems with 
cycle times of less than 1ms  

 
Interfacing the peripherals devices such as encoders is performed through PROFINET IO. 
Its basis is a cascading real-time concept. PROFINET IO defines the entire data exchange 
between controllers (devices with "master functionality") and the devices (devices with 
"slave functionality"), as well as parameter setting and diagnosis.  
 
PROFINET IO is designed for the fast exchange of data between Ethernet-based field 
devices and follows the provider-consumer model. The configuration of an IO-System has 
been kept nearly identical to the "look and feel" of PROFIBUS.  
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A PROFINET IO system consists of the following devices: 
• The IO Controller, which controls the automation task.  
• The IO Device, which is a field device such as an encoder, monitored and 

controlled by an IO Controller.  
• The IO Supervisor is software typically based on a PC for setting parameters and 

diagnosing individual IO Devices.  
 
An application relation (AR) is established between an IO Controller and an IO Device. 
These ARs are used to define communication relations (CR) with different characteristics 
for the transfer of parameters, cyclic exchange of data and handling of alarms. 
 
The characteristics of an IO Device are described by the device manufacturer in a General 
Station Description (GSD) file. The language used for this purpose is the GSDML (GSD 
Markup Language) - an XML based language. The GSD file provides the supervision 
software with a basis for planning the configuration of a PROFINET IO system. 
 
Within PROFINET IO, process data and alarms are always transmitted in real-time (RT). 
Real-time in PROFINET is based on the definition of IEEE and IEC, which allows for only a 
limited time for execution of real-time services within a bus cycle. The RT communication 
represents the basis for the data exchange for PROFINET IO and real-time data are always 
treated with a higher priority than TCP (UDP)/IP data.  

1.5 Encoder Profiles 
Profiles are pre-defined configurations of the functions and features available from 
PROFINET for use in specific devices or applications such as encoders. They are specified 
by PI (PROFIBUS & PROFINET International) working groups and are published by PI. 
Profiles are important for openness, interoperability and interchangeability, so that the 
end user can be sure that similar equipment from different vendors perform in a 
standardized way. Leine & Linde complies with the definitions in the encoder profile 3.162, 
version 4.1. The encoder device profile describing encoder functionality and additional 
information about PROFINET can be ordered from PROFIBUS User Organization, PNO or 
directly from Leine & Linde AB. 
 
PROFINET is generally defined by PROFIBUS & PROFINET International (PI) and is backed 
by the INTERBUS Club. Since 2003, it has been part of the IEC 61158 and IEC 61784 
standards. 
 
PROFIBUS User Organization 
Haid-und-Nue Stra�e 7 
D 76131 Karlsruhe 
Tel: +49 721 96 58 590 
Fax: + 49 721 96 58 589 
Web: www.profibus.com 

2. Declaration of conformities 
This device conforms to prevailing legal requirements and is designed in accordance with 
proper engineering practices. A certificate of conformity can be provided upon request 
from Leine & Linde.  
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3. Technical and commercial support 
Leine & Linde is represented by subsidiaries in many countries around the world. In 
addition to the address listed here, there are many services agencies and distributors 
located worldwide ready to reply to commercial enquires or technical support. For more 
information, please visit our website or contact Leine & Linde in Strängnäs, Sweden. 
 
Leine & Linde AB 
Olivehällsvägen 8   
SE-645 21 Strängnäs, Sweden 
Tel: +46 152 265 00 
Fax: +46 152 265 05 
E-mail: info@leinelinde.com  
Web: www.leinelinde.com  

3.1 References 
Profile Encoders for PROFIBUS and PROFINET V4.1, Order No 3.162  
 
Profile Drive Technology, PROFIdrive V4.1, Profibus International, Order Nr: 3.172 
 
PROFIBUS Encoder Profile V1.1, Profibus International, Order Nr: 3.062 
PROFIBUS Guidelines, Part 1: Identification & Maintenance Functions V1.1, Profibus 
International, Order Nr: 3.502 
 
PROFIBUS Guidelines, Part 3: Diagnosis, Alarms and Time Stamping V1.0, Profibus 
International, Order No. 3.522 
 
PROFINET – Application Layer Service Definition – Application Layer Protocol 
Specification, Version 2.0, Profibus International, Order No. 2.332 
 
PROFIBUS Guidelines: PROFIBUS Interconnection Technology V1.1, Profibus International, 
Order No. 2.142 
 
PROFINET Guidelines: PROFINET Cabling and Interconnection Technology V1.99, Profibus 
International, Order No. 2.252 

3.2 Abbreviations 
PI PROFIBUS and PROFINET International 
IO Input/Output 
DO  Drive Object 
DU Drive unit 
AR Application Relation 
CR  Communication Relation 
MLS  Master Sign-Of-Life 
RT  Realtime Ethernet 
IRT  Isochronous Realtime Ethernet 
IsoM  Isochronous Mode 
LLDP Link Layer Discovery Protocol 
GSD General Station Description 
GSDML General Station Description Markup Language 
UDP User Datagram Protocol 
TCP Transmission Control Protocol 
IP Internet protocol 
DHCP Dynamic Host Configuration Protocol 
TFTP Trivial File Transfer Protocol 
MAC Media Access Control 
I&M Identification & Maintenance 
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4. Installation 
A summary of the PROFINET guideline: PROFINET Cabling and interconnection 
Technology V 1.99, Profibus International, Order No 2.252 is provided in this section. 

4.1 Cables and standards 
Two shielded copper cables twisted in pairs are defined as the normal transmission 
medium for PROFINET networks. In such networks, the signal transmission is performed 
in accordance with 100BASE-TX at a transmission speed of 100 Mbps (Fast-Ethernet). 
 
Only shielded cables and connecting elements are allowed in a PROFINET network. The 
individual components have to satisfy the requirements of Category 5 in accordance with 
IEC 11801. The entire transmission path has to meet the requirements of Class D in 
accordance with IEC 11801. Furthermore, PROFINET cables must have a cable cross-
section of AWG 22 in order to enable even complex cabling structures through minimum 
damping. For this reason, the specification of the PROFINET cables supports a modular 
setup, which ensures an IEC 11801-compliant structure in adherence to simple installation 
rules.  
 
Transmission channel lengths are determined by the type of cable being used. The choice 
of cable shall be such that a transmission channel length of 100 meters is achieved 
between two active network devices. The use of a high number of plug connections has a 
negative effect on attenuation and reflection and consequently reduces the transmission 
channel length. A maximum of three interconnections can be inserted between two active 
devices without reduction of the permissible transmission lengths of 100 meters. 
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4.2 Connectors and pin configuration 
A major criterion for use in industry is the handling of local connection systems. 
Connectors for M12 are available for this purpose. 
 
M12 connectors are used for PROFINET data communication of the encoder, constituted 
by a 4-pin female shielded D-coded version. 
 
The correct arrangement of the bus connectors is specified as follows: 
 
 
 
 
 
 
 
 
 
 
 
Note: The encoder provides integrated switch functionality between the two M12 
connectors used for PROFINET communication. It is important to distinguish between 
these ports when IRT-communication is being used.  
 
The M12 connectors used for power supply of the encoder is constituted by a 4-pin male 
shielded A-coded version. 
 
The correct arrangement of the power supply line is specified as follows: 
 
 
 

Signal Function Pin 

+E Volt Power supply (10..30 Vdc) 1 

Not connected - 2 

0 Volt 0 Volt 3 

Not connected - 4 

 
 
Note: It is not possible to use passive T-couplings in a PROFINET network.  All devices 
must be connected through active network components 
 

Signal Function Pin 

Tx+ Transmission data + 1 

Tx- Transmission data - 3 

Rx+ Receiver data + 2 

Rx- Receiver data - 4 

Port 1 

Port 2 

Supply 
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4.3 Shielding concept of the encoder 
Automation systems in an industrial environment are subjected to high levels of 
electromagnetic disturbance. Switching large electrical loads creates high interference 
levels that can be picked up in various ways by electronic devices with detrimental effects. 
Even under such conditions, electrical components within an automation system must 
still guarantee a continuous, uninterrupted function.  
 
The electromagnetic compatibility (EMC) of the entire plant must be ensured by using 
suitably designed components and assembling them correctly to create the system. Data 
cabling is considered a passive system and cannot be tested for EMC compliance 
individually. Nevertheless, cabling and connection elements for PROFINET support 
compliance with device requirements by providing a high-quality, comprehensive 
shielding concept.  
 
To achieve the highest possible noise immunity and resistance against other EMC related 
disturbances, the bus and power supply cables must always be shielded. The screen 
should be connected to ground on both ends of the cable. In certain cases, compensation 
current might flow over the screen.   
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4.4 MAC-address 
To make the device unique, it is given an ID, i.e. the MAC address, which is a string loaded 
in the device. The MAC address is constituted by a 6-byte Ethernet address for each 
individual station and is unique worldwide. A MAC-ID consists of two parts, the first 3 
bytes represents the manufacturer-specific ID and the last 3 bytes represents a 
consecutive number. For the encoder, the MAC address is always printed on the encoder 
label for commissioning purposes. See picture below. 
 

 

4.5 LED indication 
The following table defines diagnostic indications shown by the encoders two bi-colored 
LEDs. 
 

Bus Module Meaning Cause 

Off Off No power  

Red Green No connection to another device.            
Criteria: No data exchange 

‐ Bus disconnected 
‐ Master not available / 

switched off 

Blinking* red Green 

Parameterization fault, no data exchange
Criteria: Data exchange correct,  
however the encoder did not switch to 
the data exchange mode 
 

‐ Slave not configured yet 
or wrong configuration 

‐ Wrong station address 
assigned 

‐ Actual configuration of 
the slave differs from the 
nominal configuration 

Green Red System failure Diagnosis exists, slave in data   
exchange mode 

Green Green Data exchange and encoder functions 
properly  

Blinking* green Blinkinga green Firmware upgrade in process  

Blinking* red Blinkinga red Failure during firmware upgrade  

 *) The blinking frequency is 0.5 Hz. Minimal indication time is 3 seconds 
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5. Configuration example 
This chapter will illustrate how to setup and configure a PROFINET encoder for working in 
RT Class 1 mode with SIMATIC MANAGER. In the following examples, Siemens STEP 7 V5.4 
+SP5 PLC and CPU 315F-2PN/DP are used. Please refer to the manufacturer if other 
configuration tools are being used. 

5.1 Device description file installation (GSDML) 
In order to start using an absolute encoder with PROFINET interface, a device description 
file needs to be downloaded and imported to the configuration software. The device 
description file is called a “Generic Station Description Markup Language” file and contains 
the necessary implementation parameters needed for a PROFINET IO device. 
 
The latest available GSDML file can be downloaded from www.leinelinde.com 
  
Available GSDML file Note 

GSDML-V2.2-LL-PROFINET-ENCODER-xxxxxxxx.xml 

This GSDML file requires: 
SIMATIC STEP 7 V5.4 +SP5 or later or  
SIMOTION SCOUT V4.1.5.6 or later. 
 
This GSDML file is only supported by encoders with 
software Revision V3.2.0, which are delivered in 
encoders with serial number 30125167 or higher and 
have been delivered after 01-01-2011. Older encoders 
with lower serial numbers need a firmware upgrade to 
support this GSDML file. 

 
Old supported GSDML file Note 

GSDML-V2.2-LL-RxA600-xxxxxx.xml This GSDML file is only supported for compatibility 
reasons and should not be used by new users. 
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Installation of GSDML-files in SIMATIC MANAGER: 
 

 
 

1) Select Options -> Install GSD File and click the “Browse” button to navigate to the 
location of the GSD file. If a bitmap picture representing the encoder is requested, 
make sure that the bitmap file is located in the same folder as the GSDML file. A 
bitmap file is included in the zip-file downloadable from www.leinelinde.com. 
 

2) Select the GSD file and click the “Install” button to start installing the selected GSD 
file.  
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5.2 Setting the encoder configuration 
Once the GSD file has been installed, the encoder type can be found in the SIMATIC 
MANAGER-> HW Config under PROFINET IO->Additional Field Devices->Encoders->LEINE 
LINDE PROFINET Encoders. Select either multi-turn 25 bit or single-turn 13 bit encoder, 
depending on the type of encoder to be configured. Drag and drop the encoder onto the 
PROFINET IO system as shown in the picture below. In the example below, one 25 bit 
multi-turn encoder was chosen. If more than one encoder is connected and is to be 
configured, then the following steps need to be performed once for each connected device. 
 

 
 
When correctly done, the encoder will appear on the PROFINET IO system as shown in the 
picture below. 
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The next step is to choose the data length and the type of data that is to be sent to and 
from the controller. This is done by choosing different telegrams.  
 
Available telegrams for the multi-turn 25 bit encoder can be found under Multiturn 25 Bit 
> EO Multiturn. In the example below, standard telegram 81 which contains 32 bits 
position values is used. Drag and drop the telegram onto slot 1, sub-slot 2 as shown in the 
picture below. For more information regarding the different telegrams refer to chapter 6.4. 
 

 
 
The “Standard Telegram 81” will appear on slot 1 sub slot 2. 
 

 
 
Please note that the steps described above need to be performed for each connected 
device. 
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5.3 Set encoder device name 
In a PROFINET network, all IO devices need to have a unique device name. Leine & Linde’s 
PROFINET encoders are delivered without any device name preset from the factory. To set 
the encoder device name, double-click on the encoder icon to open the Properties window. 

 
In the Properties dialog window, enter an appropriate device name in the “Device name” 
field.  
 

 
 
Make sure that the checkbox “Assign IP address via IO controller” is checked, if the IP-
address for the encoder should be assigned via the IO controller. 
 
Then select PLC-> Ethernet->Assign Device Name to open the “Assign device name 
window”. 
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Choose the device on which the device name should be changed and then click the “Assign 
name” button to adopt the changes. Then click the “Close” button. 
 

 
 
Please note that all connected devices need to be assigned a device name. 
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After changing device name, it is recommended to verify the performed changes. 
This is done by opening the “Verify Device Name” window found under PLC->Ethernet-
>Verify Device Name. 
 

 
 
 
In the “Verify Device Name” dialog window, verify that the “Device name” has changed 
and the status is confirmed OK as shown in the picture below.  



PROFINET USER MANUAL                                                                                                                Leine & Linde AB   
 
 
 

  
Part Id: 735795-01 20 
Document Id: 735795 Ver. 02   
Publication date: 2011-06-29 
 

5.4 Setting encoder parameters 
This chapter describes how to change the user parameters in the encoder. The way to 
open the Properties window depends on which version of GSDML-file is used. To set the 
parameter data while using a GSDML-file with a release date earlier than 01-01-2010, 
double click on the field beneath slot 0 according to the picture below to open the 
Properties window. The release date of the GSDML-file forms part of the filename of the 
file. For example: “GSDML-V2.2-LL-RxA600-20090512.xml” was released the 12th May 2009. 
 

 
 
To set the encoder user parameters using a GSDML-file with a release date after  
01-01-2010, double click on the “Parameter Access point” field located beneath slot 1.1 as 
shown below to open the Properties window. 
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In the Properties window, choose the “Parameters" tab. 
To set the parameter data, change the value of the different parameters by clicking on the 
drop-down list in the “Value” field for the respective parameter. Please note that the 
parameter “Class 4 Functionality” must be enabled in order to change some of the 
available parameters. For more information regarding this, see chapter 9. 

 
 
Once the configuration and parameterization of the device has been completed, the 
settings need to be saved and compiled. This is done by clicking on the “Save and Compile” 
option under the “Station” tab.  
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The settings then need to be downloaded to the IO-controller. 
This is done by clicking on the “Download” option under the “PLC” Tab. 
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5.5 Isochronous Real-Time Settings (RT Class 3) 
This example is intended to illustrate the commissioning of a PROFINET encoder in 
isochronous operation. In the example below, a STEP 7 v5.4 SP5 and SIMOTION D435 
motion controller is used. The basic principal for configuration and parameterization of 
the encoder is the same as described in chapter 5.2 & 5.3. 
 
To set the IRT settings of a Leine & Linde encoder, double-click on the “Interface” field 
located under slot 0, sub slot X1 to open the Properties window and follow the instructions 
below. 
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Under the “Synchronization” tab, change the value for the Parameter “RT Class” to IRT and 
the “IRT option” parameter to “High Performance” according to the picture below. 
 

 
 
Under the “Application tab”, check the box for “Operate IO device/application in 
isochronous mode”. 
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Under the “IO Cycle” tab, change the Update Time Mode to “fixed factor”. 
 

 
 
Before the encoder can operate in IRT mode, it is necessary to set from which port of the 
encoder the connection to the network has been made.  
 
To set the topology, double-click on the port from which the encoder is connected to the 
network. This is either slot 0 sub-slot P1 or slot 0 sub-slot P2. In the example below, Port 1 
is used on the encoder. For port description of the encoder, refer to chapter 4, Mechanical 
installation. 
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Under the “Topology” tab, change the “Partner port:” to the port used by your  
IO controller. 
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Once the above steps have been performed, it is recommended that you verify the setting 
for the encoder and the IO controller is correct. This is done by opening the “Domain 
management” Window found under Edit->PROFINET IO. 
 
Verify that the RT Class is set to IRT and that the IRT option is set to High performance. 
 

 
 
The encoder is now prepared for operating in IRT mode. 
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6. PROFINET IO data description 

6.1 Encoder Profile overview, PNO order no. 3.162 
This manual relates to encoders that fulfill the demands and functionality according to 
encoder profile V4.1 (PNO no 3.162). The operating functions for encoders according to this 
profile are divided into two application classes, named Class 3 and Class 4. For an 
overview of the different encoder profile for PROFIBUS and PROFINET and the related 
standards, see the picture below. 
 
For further information regarding the encoder functionality, refer to the device profile. 
The profile and PROFINET technical information can be ordered at PNO in Karlsruhe, 
Germany (www.profinet.com). 
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6.2 Application Class definition 
Leine & Linde’s PROFINET encoders can be configured as a class 3 or class 4 PROFINET IO-
device according to the encoder profile V.4.1 (PNO no 3.162). A Class 4 configured encoder 
from Leine & Linde fully supports all functionality according to the encoder profile V4.1 
(3.162). 
 
CLASS 3 Encoder with base-mode parameter access and limited parameterization of 

the encoder functionality. Isochronous mode is not supported.  
  
CLASS 4 Encoder with scaling, Preset and base-mode parameter access. 

Isochronous mode is supported. 

6.3 Standard signals 
The table below describes the standard signals that are used to configure the IO data. The 
signals are described in the chapters that follow. 
 

Significance Abbreviation Length 
(bits) 

Data type 

Velocity value A NIST_A 16 Signed 

Velocity value B NIST_B 32 Signed 

Control word G1_STW 16 Unsigned 

Status word G1_ZSW 16 Unsigned 

Position value 1 G1_XIST 1 32 Unsigned 

Position value 2 G1_XIST2 32 Unsigned 

Position value 3 G1_XIST3 64 Unsigned 

Control word 2 STW2_ENC 16 Unsigned 

Status word 2 ZSW2_ENC 16 Unsigned 
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6.4 Standard telegrams 
Configuration of PROFINET encoders are made by choosing different telegram structures. 
The telegrams are used to specify the data length and which type of data that are sent to 
and from the IO-controller. A configuration error will occur if for example a 37 bits multi-
turn encoder is used and have been configured with telegram 81-83. A 37 bit encoder need 
telegram 84 which supports 64 bit position values. 
 
Leine & Linde’s PROFINET encoders support the following telegrams: 
 
Standard Telegram 81:  
Standard telegram 81 uses 4 bytes for output data from the IO-controller to the encoder 
and 12 bytes of input data from the encoder to the IO-controller.  
 
Output data from the IO-controller: 
Control word 2 = STW2_ENC 
Control word =  G1_STW 
 

IO Data (word) 1 2 

Byte 0 1 2 3 

Set point STW2_ENC G1_STW 

Output data from IO-Controller 
 

Input data to the IO-controller: 
Status word 2= ZSW2_ENC 
Status word= G1_ZSW 
Position value 1= G1_XIST1 
Position value 2= G1_XIST2 
 

IO Data (word) 1 2 3 4 5 6 

Byte 0 1 2 3 4 5 6 7 8 9 10 11

Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 

Input data to IO-Controller 
 
Standard Telegram 82:  
Standard telegram 82 uses 4 bytes for output data from the controller to the encoder and 
14 bytes of input data from the encoder to the controller. 
 
Output data from the IO-controller: 
Control word 2= STW2_ENC 
Control word = G1_STW 
 

IO Data (word) 1 2 

Byte 0 1 2 3 

Set point STW2_ENC G1_STW 

Output data from IO-Controller 
 

Input data to the IO-controller: 
Status word 2= ZSW2_ENC 
Status word = G1_ZSW 
Position value 1 = G1_XIST1 
Position value 2 = G1_XIST2 
Velocity value A= NIST_A 

 
IO Data (word) 1 2 3 4 5 6 7 

Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13 

Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 NIST_A 

Input data to IO-controller 
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Standard Telegram 83:  
Standard telegram 83 uses 4 bytes for output data from the controller to the encoder and 
16 bytes of input data from the encoder to the controller. 
 
Output data from the IO-controller: 
Control word 2 = STW2_ENC 
Control word = G1_STW 
 

IO Data (word) 1 2 

Byte 0 1 2 3 

Set point STW2_ENC G1_STW 

Output data from IO-controller 
 
Input data to the IO-controller: 
Status word 2 = ZSW2_ENC 
Status word = G1_ZSW 
Position value 1 = G1_XIST1 
Position value 2 = G1_XIST2 
Velocity value B = NIST_B 
 

IO Data (word) 1 2 3 4 5 6 7 8 

Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 NIST_B 

Input data to IO-controller 
 
Standard Telegram 84:  
Standard telegram 84 uses 4 bytes for output data from the controller to the encoder and 
20 bytes of input data from the encoder to the controller. 
 
Output data from the IO-controller: 
2 bytes “Control word 2” (STW2_ENC). 
2 bytes “Control word” (G1_STW). 
 

IO Data (word) 1 2 

Byte 0 1 2 3 

Set point STW2_ENC G1_STW 

Output data from IO-controller 
 
Input data to the IO-controller: 
Status word 2 = ZSW2_ENC 
Status word = G1_ZSW 
Position value 3 = G1_XIST3 
Position value 2 = G1_XIST2 
Velocity value B = NIST_B 
 

IO Data (word) 1 2 3 4 5 6 7 8 9 10 

Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

Actual value ZSW2_ENC G1_ZSW G1_XIST3 G1_XIST2 NIST_B 

Input data to IO-controller 
 
Note: In standard telegram 84, G1_XIST2 is used to transfer error codes and optionally 
position values if the measuring length exceeds 64 bits. 
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6.5 Format of G1_XIST1 and G1_XIST2 
The G1_XIST1 and G1_XIST2 signals consist of the absolute position value in binary 
format. By default, the G1_XIST 1 signal is equal to the G1_XIST2 signal.  The format of the 
actual position values in G1_XIST1 and G1_XIST2 is shown below. 
 
Format definition for G1_XIST1 and G1_XIST2: 

• All values are presented in binary format 
• The shift factor is always zero (right aligned value) for both G1_XIST1 and 

G1_XIST2. 
• The setting in the encoder parameter data affects the position value in both 

G1_XIST1 and G1_XIST2. 
• G1_XIST2 displays the error telegram instead of the position value if error occurs. 

 
 
Example: 25-bit multi-turn absolute encoder (8,192 steps per revolution, 4,096 

distinguishable revolutions) 
 
M = Multi-turn value (Distinguishable revolutions)  
S = Single-turn value (number of steps per revolution) 
 
 
31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

       M M M M M M M M M M M M S S S S S S S S S S S S S 
 
 
Absolute value in G1_XIST1 
 
31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

       M M M M M M M M M M M M S S S S S S S S S S S S S 

 
 
Absolute value in G1_XIST2 
 

6.6 Format of G1_XIST3 
G1_XIST3 is a 64-bit position value that is used to support encoders with a resolution 
exceeding 32 bits. 
 
Format definition for G1_XIST3: 

• Binary format 
• The actual position value is always right aligned; a shifting factor is not used. 
• The settings in the encoder parameter data affect the position value in G1_XIST3 if 

Class 4 is enabled. 
 

IO Data (word) 1 2 3 4 

Format 64 bit position value 

 

6.7 Control word 2 (STW2_ENC) 
The control word 2 (STW2_ENC) is referred to as the “master sign-of-life” and it includes 
the fault buffer handling and Control by PLC mechanism from PROFIdrive STW1 and the 
Controller Sign-Of-Life mechanism from PROFIdrive STW2. This signal is mandatory for 
controlling the clock synchronization. 
 
 
 

LSB

LSB

MSB 

MSB 
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Bit Function 

0…6 Reserved 

7 Fault Acknowledge 

8, 9 Reserved 

10 Control by PLC 

11 Reserved 

12…15 Controller Sign-Of-Life 

STW2_ENC definition and implementation requirements 
 

Bit Value Significance Comments 

7 1 Fault Acknowledge 

(0->1) 

The fault signal is acknowledged with a positive edge. The 
encoder reaction to a fault depends on the type of fault. 

0 No significance  

10 1 Control by PLC Control via interface, EO IO Data is valid.  

0 No Control by PLC EO IO Data not valid, except Sign-Of-Life 

12-15  Controller Sign-Of Life  

Detailed assignment of the encoder control word 2 (STW2_ENC) 

6.8 Status word 2 (ZSW2_ENC) 
The status word 2 (ZSW2_ENC) is referred to as the “slave’s sign-of-life” and it includes the 
fault buffer handling and Control by PLC mechanism from PROFIdrive ZSW1 and the Slave 
Sign-Of-Life mechanism from PROFIdrive ZSW2. This signal is mandatory for controlling 
the clock synchronization. 
 

Bit Function 

0…2 Reserved 

3 Fault Present / No Fault 

4…8 Reserved 

9 Control requested 

10, 11 Reserved 

12-15 Encoder Sign-Of-Life 

ZSW2_ENC definition and implementation requirements 
 

Bit Value Significance Comments 

3 1 Fault Present Unacknowledged faults or currently not acknowledged faults 
(fault messages) are present (in the buffer).The fault reaction is 
fault-specific and device-specific. The acknowledgement of a 
fault may only be successful if the fault cause has disappeared 
or has been removed before. If the fault has been removed, the 
encoder returns to operation. The related fault numbers are in 
the fault buffer. 

0 No Fault  

9 1 Control requested The automation system is requested to assume control. 

0 No Control requested Control by automation system is not possible; only possible at 
the device or through another interface. 

12-15  Encoder Sign-Of-Life  

Detailed assignment of the encoder status word 2 (ZSW2_ENC) 
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6.9 Control word (G1_STW) 
The control word controls the functionality of major encoder functions. 
 

Bit 

 

Function 

0…7 Function requests: Reference mark search, measurement on the fly 

8…10 Reserved (without effect) 

11 Home position mode 

12 Request set/shift of home position (Preset) 

13 Request absolute value cyclically 

14 Activate parking sensor 

15 Acknowledging a sensor error 

G1_STW implementation requirements 
 

Note: If the sensor parking is activated (bit 14 = 1), the encoder remains on the bus with 
the slave sign–of-life activated and the encoder error and diagnostics switched off. 

6.10 Status word (G1_ZSW) 
The status word defines encoder states, acknowledgements, error messages of major 
encoder functions. 
 

Bit 

 

Function 

0…7 Function status: Reference mark search, measurement on the fly 

8 Probe 1 deflected 

9 Probe 2 deflected 

10 Reserved, set to zero 

11 Requirement of error acknowledgement detected 

12 Set /shift of home position executed 

13 Transmit absolute value cyclically 

14 Parking sensor active 

15 Sensor error 

G1_ZSW implementation requirements 
 
Note: If bit 13 “Transmit absolute value cyclically” or bit 15 “Sensor error” is not set, there 
is no valid value or error code transferred in G1_XIST2. 
 
Note: Bit 13 “Transmit absolute value cyclically” cannot be set at the same time as bit 15 
“Sensor error” as these bits are used to indicate either a valid position value transmission 
(bit 13) or the error code transmission (bit 15) in G1_XIST2. 

6.11 Real Time Communication 
PROFINET IO uses three different communication channels to exchange data with 
programmable controllers and other devices. The non real-time channel, based on for 
example TCP (UDP)/IP, is used for parameterization, configuration and acyclic read/write 
operations.  
 
The RT or Real-Time channel is used for process data transfer and alarms. 
Real-time data are treated with a higher priority than data sent over the open channel. RT 
communications overrides the open channel to handle the data exchange with 
programmable Controllers.  
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The third channel, Isochronous Real-Time (IRT) is the high performance, high-speed 
channel used for demanding motion Control applications. IRT data are treated with a 
higher priority than RT data sent over the RT channel. 
 

 
 
PROFINET distinguishes between three real-time classes for transmission of time-critical 
process data. The three RT classes are: 
  
Real-Time, RT Class 1 

• Unsynchronized Real-time communication 
• Industrial standard switches can be used. 
• Typical application area: Factory automation 

 
Real-Time, RT Class 2 

• Synchronized and unsynchronized data transmission 
• Special switches supporting IRT is needed 
• Typical application area: Factory automation 

 
Isochronous Real-Time, RT Class 3 
The isochronous operation mode is used when real-time positioning with high-
performance is required. The basic principal is that all PROFINET devices on the net are 
clock synchronized with the controller using a global control broadcast enabling 
simultaneous data accusation from all devices with microsecond accuracy. The data 
exchange cycles for IRT are usually in the range of a few hundred microseconds up to a 
few milliseconds. The difference compared to real-time communication is essentially the 
high degree of determinism, so that the start of a bus cycle is maintained with high 
precision. The synchronization is monitored by “sign-of life” messages in “Control word 2” 
(STW2_ENC) and “Status word 2” (ZSW2_ENC). 
 

• Clock synchronized data transmission 
• Special switches supporting IRT is needed 
• IRT is required for example motion control applications 
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7. Alarms and warnings 

7.1 Diagnostics and Alarms 
Diagnostic data is always transferred acyclically using Record Data communications over 
the non real-time channel. An IO-Supervisor must specifically request the diagnostic or 
status data from the IO-device using RDO (Record Data Object) services. 
 
Alarm data is transmitted from the IO-device to the IO-controller via the RT channel. 
An alarm is generated by the encoder when a failure occurs that affects the position value. 
Alarms can be reset (deleted) once all encoder parameters are within the specified value 
ranges and the position value is correct. 

7.2 Channel diagnostics 
The encoder outputs a diagnostic interrupt to the CPU when it detects one of the 
supported channel diagnostics. 
 

Supported channel diagnostic 

 

Diagnostic data record Description 

Position error 0x900A The encoder fails to read the 
correct position value  

Memory error 0x9000 
The encoder fails to read stored 
offset or preset values from the 
non volatile memory 

Commissioning diagnostics 0x9011 User parameter data assignment 
error 

 
In a SIMATIC STEP 7 system, the operation system responds by calling a diagnostic OB. 
The OB number and start information provides the cause and location of the error. The 
error information can be read by calling a system Function block (SFB54 “RALRM” for STEP 
7). The user can then decide how the system should handle the error.  
 
Note: If the called OB is not included in the program, the CPU will go to stop. 
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7.3 Sensor status word 
Diagnosis information can be obtained by monitoring of the Error bit in the Sensor Status 
word G1_ZSW (bit 15) and evaluation of the error code transmitted in G1_XIST2. 
  

Supported diagnostic 

 

Error code in G1_XIST2 Description 

Sensor group error 0x0001 The encoder fails to read the 
correct position value  

Memory error 0x1001 The encoder fails to read stored 
offset or preset values from the 
non volatile memory 

Command not supported 0x0F01 User parameter data assignment 
error or command error in 
commands words G1_STW and 
STW2_ENC 

Master´s sign-of-life fault 0x0F02 The number of permissible failures 
the controller’s sign-of-life was 
exceeded. 

 

8. Acyclic Parameter Data 

8.1 Acyclic data exchange 
In addition to the cyclic data exchange, the PROFINET encoder also supports acyclic data 
exchange. The acyclic data exchange is transferred over the non real-time channel and is 
used to read out and write status information from and to the IO-device. The acyclic data 
exchange is conducted in parallel to the cyclic data communication.  
 
Example of acyclic data: 

• Reading of diagnostic 
• Reading of I&M functions 
• Reading of PROFIdrive parameters 

8.2 Identification and Maintenance (I&M functions) 
Encoders according to the encoder profile 3.162 also support I&M functionality. 
The main purpose of I&M functions is to support the end user if the device is acting faulty 
or missing some of its functionality. I&M functions could be seen as an electronic 
nameplate containing common information regarding the device and its manufacturer.  
 
According to the PROFINET specification all IO-devices must at least support the following 
I&M functions: 
 

• Order ID 
• MAC address 
• Hardware Version 
• Software Version 
• Product type 
• Manufacturer ID 

 
For more information regarding additional I&M functions supported by Leine & Linde 
encoders, refer to chapter 9.14.6. 
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8.3 Base Mode Parameter access 

8.3.1 General characteristics 
Acyclic parameter can be transmitted 1(single) or up to 39(multi) in one access. A 
parameter access can be up to 240 bytes long. 

8.3.2 Parameter requests and responses 
Request header: Request ID, DO-ID and number of parameters of the access. 
 
Parameter address: One address for each parameter, if several parameters are accessed. 
 
Parameter value: If the Request ID is 0x02 (change value) the value is set in the request 
and if the Request ID is 0x01 (request value), the value appears in the reply. 

8.3.4 Changing the preset value 
The table below shows the structure of a change value request. 
 

Write of Preset value, parameter 65000 
 Parameter request 

Request reference 0x00  

Request ID 0x02 0x02 Change value, 0x01 read value 

DO-ID (axis) 0x01 Drive Object ID 

No of parameters  0x01  

Attribute 0x10 0x10 Value 

No of elements 0x00  

Parameter number 0xFDE8 Parameter 65000 

Sub index 0x0000  

Format 0x04 Data type integer 32 

Number of values 0x01  
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8.3.5 Reading the preset value 
The tables below show the structure of a read value request. 
 

Read of Preset value, parameter 65000 
 Parameter request 

Request reference 0x00  

Request ID 0x01 0x01 read value 

DO-ID (axis) 0x01 Drive Object ID 

No of parameters  0x01 0x01 Read one parameter 

Attribute 0x10 0x10 Value 

No of elements 0x00  

Parameter number 0xFDE8 Parameter 65000 

Sub index 0x0000  

 
Read of Preset value, parameter 65000 

 Parameter response 

Request reference 0x00 mirrored 

Response ID 0x01 0x01 read value 

DO-ID (axis) 0x01 mirrored 

No of parameters  0x01  

Format 0x04 0x04= Data type unsigned 32 

No of values 0x01  

Values or errors 0x00,0x00,0x00,0x64 Preset value 100 

 
8.4 Supported parameters 

8.4.1 Parameter 922, read only 
922  unsigned int, presents which telegram is used. Telegram 81, 82, 83 or 84 is possible. 

8.4.2 Parameter 925, read/write 
925  unsigned int, maximum allowed MLS (Master sign-of-life) error. Parameter 925 may 
be used to set a maximum on how many consecutive Sign-of-life failures may occur. 

8.4.3 Parameter 964, read only 
964 unsigned int 
 
964[0] = Manufacturer Id. This is set during manufacturing of the encoder. 
964[1] = 0 DU Drive unit type, always set to 0. 
964[2] = 201 Software version 
964[3] = 2009 Software year 
964[4] = 2805  Software day and month 
964[5] = 1  Number of drive objects (DO) 

8.4.4 Parameter 965, read only 
965 OctetString 2 
 
965[0] =0x3D Encoder profile number 
965[1] = 31 or 41 Encoder profile version, set by customer (user_parameters) 
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8.4.5 Parameter 971, read/write 
971  unsigned int, Store the local parameter set to a non-volatile memory. Preset value is 
saved when writing value 1 and is set to 0 by the encoder firmware when finished. This 
means that the pre-set value has been saved when reading back value 0.  

8.4.6 Parameter 974, read only 
974 unsigned int 
 
974[0] = 96 Max array length supported by parameter channel. 
974[1] = 1 Numbers of multi parameters, 1 = no support of multi parameters. 
974[2] = 1000 max time to process parameter request, n x 10 ms. 

8.4.7 Parameter 975, read only 
975 unsigned int 
 
975[0] = Manufacturer Id, Set in the production. 
975[1] = 7011 DO type 
975[2] = 201 Software version 
975[3] = 2009 Software year 
975[4] = 2805 Software day and month 
975[5] = 0x0005  Profidrive DO type class 5 = encoder interface 
975[6] = 0x8000  Profidrive SUB class 1, Encoder application class 4 supported.  
975[7] = 0x0001 Drive object Id (DO ID). 

8.4.8 Parameter 979, read only 
979 unsigned long 
 
979[0] = 0x00005111  Number of index describing encoders, Numbers of described 
encoders, Version of parameter structure 
 
979[1] = 0x80000000  Sensor type 

Bit 31 = 1 if configuration and parameterization is OK 
       Bit 0 = 0 Rotary encoder, Bit 0 = 1 linear encoder  
 Bit 1 = 0 always set to 0 
 Bit 2 = 0 32 bit data, Bit 2 = 1 64 bit data 
 
979[2] = 8192  Encoder scaled resolution 
979[3] = 0 Shift factor for G1_XIST1. Always set to 0. 
979[4] = 0 Shift factor for G1_XIST2. Always set to 0. 
979[5] = 1 or 4096 Singleturn = 1, Multiturn = 4096 
979[6] = 0 
979[7] = 0 
979[8] = 0 
979[9] = 0 
979[10] = 0 
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8.4.9 Parameter 980, read only 
This parameter shows the supported parameters 
 
980 unsigned int 
 
980[0] = 922  980[8] = 61000  980[16] = 65003 
980[1] = 925  980[9] = 61001  980[17] = 0 
980[2] = 964  980[10] = 61002 
980[3] = 965  980[11] = 61003    
980[4] = 971  980[12] = 61004 
980[5] = 974  980[13] = 65000 
980[6] = 975  980[14] = 65001 
980[7] = 979  980[15] = 65002 

8.4.10 Parameter 61000, read/write 
Name of station 
 
61000 OctetString, 240 octets 

8.4.11 Parameter 61001, read only 
IP of station 
61001 unsigned long 

8.4.12 Parameter 61002, read only 
MAC of station 
61002 OctetString, 6 octets 

8.4.13 Parameter 61003, read only 
Default gateway of station 
61003  unsigned long 

8.4.14 Parameter 61004, read only 
Subnet mask of station 
61004  unsigned long 

8.4.15 Parameter 65000, read/write 
Used with telegram 81-83 
65000  signed long, preset value 32 bit. 

8.4.16 Parameter 65001, read only 
Used with telegram 81-84 
65001  unsigned long 
 
65001[0] = 0x000C0101 Header, Version of parameter structure and numbers of                        
index describing the encoder. 12 index and version 1.01 
65001[1] = Operating status (Bit 4 alarm channel control is always set with profile   version 
4.x) 
65001[2] = Alarm 
65001[3] = Supported alarms 
65001[4] = Warning 
65001[5] = Warnings supported 
65001[6] = 0x00000401  Encoder profile version. Always set to this value. 
65001[7] = Operating time 
65001[8] = Offset value 
65001[9] = Singleturn value, scaled value 
65001[10] = Total measuring length, scaled value (Linear = 1) 
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65001[11] = Velocity unit  
• step/10 ms 
• step/100 ms 
• step/1000 ms 
• RPM 

8.4.17 Parameter 65002, read/write 
Used with telegram 84 
65002  signed long long, Preset value 64 bit. 

8.4.18 Parameter 65003, read only 
Used with telegram 84 
65003  unsigned long long,  
 
65003[0] = 0x0000000000040101 Header Version of parameter structure and numbers of 
index describing encoder. 4 index and version 1.01 
65003[1] = Offset value 64 bit 
65003[2] = Singleturn value 64 bit, scaled value 
65003[3] = total measuring range in measuring units 64 bit, scaled value (Linear =1) 

8.5 Example of reading and writing to a parameter 
This is an example of S7 blocks used for reading and writing to parameter 65000 (preset 
value). Experience with S7 programming and Statement List programming language STL is 
required. 
 

Hardware components 

IO Controller SIEMENS S7-F CPU CPU 315F-2  

IO Device Leine & Linde PROFINET encoder 

 
Software components 

SIMATIC STEP 7 V5.4 +SP5 

GSDML file for PROFINET 
encoder 

GSDML V2.2-LL-Profinet-encoder-20100225 

8.5.1 Used blocs 
Write record block SFB53 “WRREC” 
Read record block SFB52 “RDREC” 
Instance data blocks DB3 and DB4 
Request data block DB1 
Response data block DB2 
Organization blocks OB1, OB82 and OB86 
 
SFB52 
SFB52 is standard S7 block for reading parameters. 
 
SFB53 
SFB53 is standard S7 block for writing parameters. 
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DB1 
DB1 is the request data block. 
 

 
 
DB2 
DB2 is the response data block. 
 

 
 
DB3 
DB3 is the instance data block of SFB52. 
 

 
 
DB4 
DB4 is the instance data block of SFB53. 
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OB1 
OB1 controls the read-and-write operation. 
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Parameters of SFB52 
 

Parameter Declaration Data type Description 

REQ INPUT BOOL REQ=1 Enables data transfer 

ID INPUT DWORD Logical address of the PROFINET IO 
module or sub module (PAP-module 
address 2039) 

INDEX* INPUT INT Record number 

MLEN* INPUT INT Maximum length of the record 
information in bytes 

VALID OUTPUT BOOL New record has been received and is 
valid. 

BUSY OUTPUT BOOL Busy=1 during the read operation 

ERROR OUTPUT BOOL Error =1 read error 

STATUS  OUTPUT DWORD  Block status or error code 

LEN* OUTPUT INT Length of record information 

RECORD IN_OUT ANY Target area for the record 

*) Negative values are interpreted as 16-bit unsigned integers. 
 
Parameters of SFB53 
 

Parameter Declaration Data type Description 

REQ INPUT BOOL REQ=1 Enables data transfer 

ID INPUT DWORD Logical address of the PROFINET IO 
module or sub module (PAP-module 
address 2039) 

INDEX* INPUT INT Record number 

LEN* INPUT INT Length of the record information in 
bytes 

DONE OUTPUT BOOL Data record was transferred 

BUSY OUTPUT BOOL Busy=1 during the write operation 

ERROR OUTPUT BOOL Error =1 write error 

STATUS  OUTPUT DWORD  Block status or error code 

RECORD IN_OUT ANY Data record 

*) Negative values are interpreted as 16-bit unsigned integers. 
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Diagnostic address of slot 1  
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Variable table 
With the variable table, the user can monitor and modify variables. 
 

 

To change the value of Parameter 65000 with the variable table perform the following 
steps: 
 
1. Enable monitoring by clicking the Monitor Variable button. 
 
2. Write 02hex to address DB1.DBB 1 by entering B#16#02 in the modify value column. 
(01hex=parameter request, 02hex=change parameter). 
 
3. Write the new preset value in hexadecimal to address DB1.DBD 12 by entering the value 
in the modify value column. (Ex: DW#16#000001F4). 
 
4. Click the button Modify variable. The status value of DB1.DBB 12 should now contain 
the new value. 
 
5. Run the program- right click on M8.4 and click “Modify address to 1” to run the program. 
Then stop the program by right click and click “Modify address to 0”. 

6. The status value of DB2.DBD 6 should now have changed to the new preset value. 
 
7. Change the value in DB1.DBB 1 to 01hex (B#16#01) and click modify variable. 

8. To set the encoder to the new preset value bit 12 in control word must be set to “1”. This 
is done by writing 1000hex (W#16#1000) to address PQW 2. Then Click the button Modify 
variable to make the preset of the encoder. 
 
9. The encoder can now at anytime be set to the preset value by setting bit 12 in control 
word.
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9. Functional description of Leine & Linde encoders 

This chapter describes the functions that have been implemented in PROFINET encoders 
from Leine & Linde. The table below shows the supported functions in a Leine & Linde 
PROFINET encoder. 
   

Function 

Code sequence 

Class 4 functionality 

G1_XIST1 Preset control 

Scaling function control 

Alarm channel control 

Compatibility mode 

Preset value 

Preset value 64 bit 

Measuring units per revolution / Measuring step 

Total measuring range 

Measuring units per revolution 64 bit 

Total measuring range 64 bit 

Maximum Master Sign-Of-Life failures 

Velocity measuring unit 

Encoder Profile version 

Operating time 

Offset value 

Offset value 64 bit 

9.1 Code sequence 
The code sequence defines whether the absolute position value should increase during 
clockwise or counter clockwise rotation of the encoder shaft seen from flange side. The 
code sequence is set by default to increase the absolute position value when the shaft is 
turned clockwise (0). 
 

Attribute Meaning Value 

CW Increasing position values with clockwise rotation 
(viewed from shaft side) 

0 

CCW Increasing position values with counter clockwise 
rotation (viewed from shaft side) 

1 

Code sequence attributes 
 
Note: The position value will be affected when the code sequence is changed during 
operation. It may be necessary to perform a preset after the code sequence has been 
changed. 
 
 
 
 
 
 
 

9.2 Class 4 functionality 
This parameter enables or disables the measuring task functions Scaling, Preset and Code 
sequence. If the function is enabled, scaling and Code sequence control affects the 
position value in G1_XIST1, G1_XIST2 and G1_XIST3. A preset will, in this case, always 
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affect G1_XIST2 and G1_XIST3 but if the parameter “G1_XIST1 Preset control” is disabled 
the preset will not affect the position value in G1_XIST1.  
 

Attribute Meaning Value 

Enable Scaling/preset/code sequence control enabled 1 

Disable Scaling/preset/code sequence control disabled 0 

Class 4 functionality attributes 

9.3 G1_XIST1 Preset control 
This parameter controls the effect of a preset on the G1_XIST1 actual value. 
If “Class 4 functionality” is activated and “G1_XIST1 Preset control” is disabled, the position 
value in G1_XIST1 will not be affected by a Preset. 
 

Attribute Meaning Value 

Enable G1_XIST1 is affected by a Preset command 0 

Disable Preset does not affect G1_XIST1 1 

G1_XIST1 Preset control attributes 
 
Note: This parameter is disabled by setting the value to 1. 
 
Note: There is no functionality of this parameter if the “Class 4 functionality” parameter is 
disabled.  

9.4 Scaling function control 
This parameter enables or disables the Scaling function of the encoder. 
 

Attribute Meaning Value 

Enable Scaling function is enabled 1 

Disable Scaling function is disabled 0 

Scaling function control attributes 
 
Note: The parameter “Class 4 functionality” must be enabled to use this parameter.  

9.5 Alarm channel control 
This parameter enables or disables the encoder specific Alarm channel transferred as 
Channel Related Diagnosis. This functionality is used to limit the amount of data sent in 
isochronous mode. 
 
If the value is zero (default value) only the communication related alarms are sent via the 
alarm channel. If the value is one (1) also encoder profile specific faults and warnings are 
sent via the alarm channel. 
 

Attribute Meaning Value 

Enable Profile specific diagnosis is switched on 1 

Disable No Profile specific diagnosis (default) 0 

Alarm channel control attributes 
 
Note: This parameter is only supported in compatibility mode. 
 



PROFINET USER MANUAL                                                                                                                Leine & Linde AB   
 
 
 

  
Part Id: 735795-01 50 
Document Id: 735795 Ver. 02   
Publication date: 2011-06-29 
 

9.6 Compatibility mode 
This parameter defines if the encoder should run in a mode compatible to Version 3.1 of 
the Encoder Profile. See below for an overview of functions affected when the 
compatibility mode is enabled. 
 

Attribute Meaning Value 

Enable Compatibility with Encoder ProfileV 3.1 0 

Disable No backward compatibility (default) 1 

Compatibility mode attributes 
 

Function Compatibility mode Enable (= 0) Compatibility mode Disabled (= 1) 

Control by PLC (STW2_ENC) Ignored, the Control word (G1_STW) 
and set point values are always valid. 
Control requested (ZSW2_ENC) is not 
supported and is set to 0. 

Supported 

User parameter “Maximum” 
Master Sign-Of-Life failures” 

Supported Not supported, one Sign-Of-Life 
failure tolerated, PROFIdrive P925 is 
optional to control the life sign 
monitoring. 

User parameter “Alarm 
channel control” 

Supported Not supported, the application alarm 
channel is active and controlled by a 
PROFIdrive parameter. 

P965 – Profile Version 31 (V3.1) 41 (V4.1) 

Compatibility mode definition 

9.7 Preset Value 
The preset value function enables adaptation of the position value from the encoder to a 
known mechanical reference point of the system. The preset function sets the actual 
position of the encoder to zero (= default value) or to the selected preset value. A preset 
value can be set more than once and it can be stored to the non-volatile memory using 
PROFIdrive parameter 971. 
 
The preset function has an absolute and a relative operating mode selectable by bit 11 in 
the Control word (G1_STW). Bit 11 and bit 12 in the Control word control the preset as 
follows: 
 
Normal operating mode:  Bit 12 = 0 
In this mode, the encoder will make no change in the output value. 
 
Preset mode absolute: Bit 11 =0, Bit 12 = 1 
In this mode, the encoder reads the current position value and calculates an internal 
offset value from the preset value and the current position value. The position value is 
then shifted with the calculated offset value to get a position value equal to the preset 
value. No preset will be made if a negative preset value is used while trying to initiate an 
absolute preset. 
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Preset mode relative: Bit 11 =1, Bit 12 = 1 
In this mode, the position value is shifted by the preset value, which could be a negative or 
a positive value set by encoder parameter 65000 or 65002. 
 
The steps below should be followed by the IO-controller when modifying the Preset value 
parameters: 
 

1. Read the requested Preset value parameter and check if the returned value meets 
the application requirements. If not, proceed with the following steps. 

2. Write the Preset value into the individual parameter. 
3. Store the value in the non–volatile memory by PROFIdrive parameter 971 if the 

value should also be valid after the next power-on sequence. 
 

Parameter Meaning Data type 

Preset value The preset value for encoders with a measuring 
range of maximum 32 bits 

Integer 32 

Preset value 64 bit The preset value for encoders with a measuring 
range exceeding 32 bits 

Integer 64 

Preset value parameters 
 
Note: The preset function should only be used at encoder standstill 
 
Note: The number of possible preset cycles is unlimited. 
 
Note: If scaling is used, the preset function should be used after the scaling function to 
ensure that the preset value is entered in the current measuring unit. 
 
Note: There is no preset activated when the Preset value is written to the encoder. The 
preset function is controlled by bits in the control and status words (G1_STW and 
G1_ZSW) and bit in the operating parameters. The preset value is used when a preset is 
requested by bit 12 in the Control word (G1_STW). 

9.8 Scaling function parameters 
The scaling function converts the encoder’s physical absolute position value by means of 
software in order to change the resolution of the encoder. The scaling parameters will only 
be activated if the parameter “Class 4 functionality” and “Scaling function control” are 
enabled. The permissible value range for the scaling is limited by the resolution of the 
encoder. The scaling parameters are securely stored in the IO-controller and are reloaded 
into the encoder at each power-up.  

9.8.1 Measuring units per revolution 
This parameter sets the single-turn resolution of the encoder. In other words, it is the 
number of different measuring steps during one revolution of the encoder. 
 
Example: For a 13-bit encoder with a single-turn resolution of 13 bits, the permissible 
value range for "Measuring units per revolution" is between 20 and 213 (8,192).  
 

Parameter Meaning Data type 

Measuring units per 
revolution  

The single-turn resolution in measuring steps Unsigned 32 

Measuring units per 
revolution 64 bit 

The single-turn resolution in measuring steps for encoders 
with a resolution exceeding 32 bits.

Unsigned 64 

Single-turn scaling parameters 
 
Note: After downloading new scaling parameters, the preset function must be used to set 
the encoder starting point to absolute position 0 or to any required starting position within 
the scaled operating range. 
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9.8.2 Total measuring range 
This parameter sets the total measuring range of the encoder. The total measuring range 
is calculated by multiplying the single-turn resolution with the number of distinguishable 
revolutions.  
 
Example: The total measuring range for a 25 bit RXA 608 multi-turn encoder with a 13 bit 
single-turn resolution and a 12 bit multi-turn resolution, the permissible value range for 
the "Total measuring range" is between 20 and 225 (33,554,432). 
 
The total measuring range is calculated as below: 
 
Measuring units per revolution x Total measuring range   
 = 8,192 (213) x 4,096 (212) 
= 33,554,432 
 
If the total measuring range is higher than 31 bit, telegram 84 and acyclic encoder 
parameter 65002 and 65003 must be used. In this case, the 64-bit values are used and the 
32-bit values are set to zero (0) by the encoder. 
 
The device has two different operating modes, depending on the specified measuring 
range. When the device receives a parameter message, it checks the scaling parameters to 
identify if a binary scaling can be used. If binary scaling can be used, the device selects 
operating mode A (see following explanation). If not, operating mode B is selected. 
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A. Cyclic operation (binary scaling) 
Cyclic operation is used when operating with 2X number of turns (2, 4, 8, 16, 32, 64, 128, 
256, 512, 1,024, 2,048, 4,096….. number of turns). If the desired total measuring range is 
equal to the specified single turn resolution * 2X (where x<= 12) the encoder operates in 
endless cyclic operation (0 – max – 0 –max…). If the position value increases above the 
maximum value by rotating the encoder shaft, the encoder continues from 0. 
 
 
Example of a cyclic scaling: 
Measuring units per revolution  = 1,000 
Total measuring range  = 32,000 (25 = number of revolutions 32) 
 
 

 
 

Cyclic Scaling 
 
 
B. Non-cyclic operation 
If the desired total measuring range is not equal to the specified single turn resolution * 2X 
(where x<= 12) the encoder operates in non-cyclic operation. The non-cyclic operation is 
affected by the parameter G1_XIST 1 Preset control as described below. 
 
G1_XIST 1 Preset control = Enabled 
If the position value increases or decreases outside the maximum value or below 0 with 
the parameter G1_XIST 1 Preset control enabled, the device outputs the maximum 
position value within the scaled total range for both position values G1_XIST 1 and 
G1_XIST 2. 
 
Example of non-cyclic scaling with G1_XIST 1 Preset control enabled : 
Measuring units per revolution  = 100 
Total measuring range  = 5,000 (number of revolutions 50) 
 
 

 
 

Non-cyclic scaling with G1_XIST 1 Preset control enabled 
 
 
 



PROFINET USER MANUAL                                                                                                                Leine & Linde AB   
 
 
 

  
Part Id: 735795-01 54 
Document Id: 735795 Ver. 02   
Publication date: 2011-06-29 
 

 
G1_XIST 1 Preset control = Disabled 
With the parameter G1_XIST 1 disabled, and if the position value increases or decreases 
outside the maximum value or below 0, the device will output the maximum position 
value within the scaled total range for the position value  
G1_XIST 2. The position value G1_XIST 1 is not limited to the scaled total range. For the 
position value G1_XIST 1, the device will continue to output a scaled position value within 
the encoder’s total measuring range (up to 33,554,432 positions for a 25-bit encoder). 
 
Example of non-cyclic scaling with G1_XIST 1 Preset control disabled: 
Measuring units per revolution  = 100 
Total measuring range  = 5,000 (number of revolutions 50) 
 

 
Non-cyclic scaling with G1_XIST 1 Preset control disabled 

 
Handling 64-bit data 
Siemens hardware configuration tool does not support 64-bit data type, so when writing 
larger numbers than 32 bit into the configuration tool, this needs to be done according to 
below: 
 
Example:  
Total measuring range in measuring units = 236   
 
 
236= 68719476736 = 0x 00 00 00 10  00 00 00 00 
 
 
  
Take the 4 least significant bytes above and convert to decimal: 

0x00 00 00 00 = 0  = Total measuring range LSB 
 
Then take the 4 most significant bytes above and convert to decimal: 

0x00 00 00 10 = 16 = Total measuring range MSB  
 
 
In the configuration software enter the decimal values: 
Total measuring range LSB = 0 
Total measuring range MSB = 16 
 
 

 4 4 byte = 32 bit  4 byte = 32 bit 

MSB LSB 
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9.9 Maximum Master Sign-Of-Life failures 
With this parameter, the number of allowed failures of the master´s sign-of-life is defined. 
The default value is one (1). 
 

Parameter Meaning Value 

Maximum Master Sign-Of-Life failures The number of permissible failures of the master´s sign-
of-life.

1…255 

Maximum Master Sign-Of-Life parameter 
 
Note: This parameter is only supported in compatibility mode. 

9.10 Velocity measuring units  
This parameter defines the coding of the velocity measuring units used to configure the 
signals NIST_A and NIST_B. Standard telegram 81 has no velocity information included 
and the encoder does not use the velocity unit information in this case. Telegram 82, 83 
and 84 includes velocity output and need a declaration of the velocity measuring unit. 
 

Parameter Meaning Value 

Velocity measuring units Definition of the units for the Encoder velocity output 
value.

See table 
below 

Parameter Velocity measuring unit 
 

Velocity measuring units Value 

Steps/s 0 

Steps/100 ms 1 

Steps/10 ms 2 

RPM 3 

Coding of velocity measuring units 
 
The velocity calculations are made with a maximum of 19 bits resolution. If the resolution 
is higher than 219, the value used for velocity calculations is automatically reduced to 219. 
 
Example: For a 37-bit multi-turn encoder with a 225 single-turn resolution and a 212 multi-
turn resolution, the maximum single-turn value for velocity calculations will be 219. For a 
single-turn encoder the maximum resolution can be up to 31 bit, but the value used for 
velocity calculations will in this case also be 219. 
 
Note: In case of the steps/s unit, an average is made over 200 ms, and the value is 
multiplied by 5. 
 
Note: If scaling has been set on the device, the velocity calculation is based on the scaled 
position value. Consequently the accuracy of the velocity value is dependent of the scaling 
set to the device. 

9.11 Encoder profile version 
The encoder Profile Version is the version of the encoder profile document implemented in 
the encoder. This parameter is not affected by the Compatibility mode settings. 
 

Bits Meaning 

0…7 Profile Version, least significant number, (value range: 0-99), decimal coding 

8…15 Profile Version, most significant number, (value range: 0-99), decimal coding 

16…31 Reserved 

Encoder profile version Parameter 
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9.12 Operating time 
The operating-time monitor stores the operating time for the device in operating hours. 
The operating time is saved every six minutes in the non-volatile memory in the device. 
This happens as long as the device is powered on.  
 
If the operating time function is not used, the operating time value is set to the maximum 
value (0xFFFF FFFF).  
 

Parameter Meaning Data type  

Operating time The accumulated power on time Unsigned 32 

Operating time parameter 
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9.13 Offset value 
The offset value is calculated in the preset function and shifts the position value with the 
calculated value. The offset value is stored in a non-volatile memory and can be read from 
the encoder at any time. The data type for the offset value is a 32-bit or 64-bit binary value 
with sign, whereby the offset value range is equal to the measuring range of the device.  
 
The preset function is used after the scaling function. This means that the offset value is 
indicated according to the scaled resolution of the device.  
 

Parameter Meaning Data type  

Offset value The offset value for encoders with a measuring range of 
maximum 32 bits 

Integer 32 

Offset value 64 bit The offset value for encoders with a measuring range 
exceeding 32 bits 

Integer 64 

Offset value parameter 
 
Note: The offset value is read only and cannot be modified by a parameter write access. 

9.14 Acyclic data  
Leine & Linde’s PROFINET encoders support the following acyclic data exchange functions. 

9.14.1 PROFIdrive parameters  
The encoder profile V4.1 (PNO no. 3.162) has adopted certain standard PROFIdrive 
parameter. The Leine & Linde encoders support the following PROFIdrive parameters:  
 

PNU (Prm.no) Significance Data type  Read/Write 

922 Telegram selection Unsigned 16 R 

925 Number of Controller Sign-Of-Life 
failures which may be tolerated 

Unsigned 16 R/W 

964 Device indentification Array [n] Unsigned 16 R 

965 Encoder Profile Number Octet string 2 R 

971 Transfer to non volatile memory Unsigned 16 W 

974 Base Mode Parameter Access service 
identification 

Array [n] Unsigned 16 R 

975 Encoder Object identification Array [n] Unsigned 16 R 

979 Sensor format Array [n] Unsigned 32 R 

980 List of supported parameters Array [n] Unsigned 16 R 

PROFIdrive parameters supported 
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9.14.2 Encoder parameter numbers 
The table below specifies the encoder specific parameter that is supported by Leine & 

Linde PROFINET encoders. 
 

PNU Prm. No Significance Data type  Read/Write 

61000 Name of station Octet String [240] R 

61001 IP of station Unsigned32 R 

61002 MAC of station Octet String[6] R 

61003 Default gateway of station Unsigned 32 R 

61004 Subnet Mask Of Station Unsigned 32 R 

65000 Preset value Integer 32 R/W 

65001 Operating status Array [n] Integer 32 R 

65002 Preset value 64 bit Integer 64 R/W 

65003 Operating status 64 bit Array [n] Integer 64 R 

Encoder specific parameter 

9.14.3 Parameter 65000 and 65002 – Preset value 
The parameter 65000 and 65002 sets the value for the preset function. The parameter 
65002 should be used if the preset value exceeds 32 bits. For more information regarding 
the Preset function control, see chapter 9.7. 
 

PNU  65000  

Significance Preset value  

Data type Integer 32 

Access Read and write 

Validity range Profile specific 

Explanation The preset value sets the value for the preset function. The preset value can be stored 
in the non volatile memory by PROFIdrive parameter 971 and will be reloaded at each 
start up if stored. 

Structure of parameter 65000 "Preset value" 
 

PNU  65002 

Significance Preset value 64 bit 

Data type Integer 64 

Access Read and write 

Validity range Profile specific 

Explanation The preset value sets the value for the preset function. The preset value can be stored 
in the non volatile memory by PROFIdrive parameter 971 and will be reloaded at each 
start up if stored. 

Structure of parameter 65002 "Preset value 64 bit" 
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9.14.4 Parameter 65001 –Operating status parameter structure 
This parameter structure is a read only structure, where information on the Encoder 
operating status can be found. It is a complement to the PROFIdrive parameter 979 
described in the Profile for Drive Technology, PROFIdrive V4.1, Order nr 3.172 available 
from PROFIBUS and PROFINET International. 
 

PNU  65001 

Significance Encoder Operating Status 

Data type Array[n] Integer 32 

Access Read 

Validity range Profile specific 

Explanation The operating status displays the status of the encoder. 
 

 
Sub index Meaning 

0 Header 

1 Operating status 

2 Faults 

3 Supported Faults 

4 Warnings 

5 Supported warnings 

6 Encoder Profile version 

7 Operating time 

8 Offset value 

9 Measuring units per revolution 

10 Total measuring range in measuring units 

11 Velocity measuring unit 

Structure of parameter 65001 "Operating status" 
 
Sub index 1: Operating status 
In sub-index 1, the status of different encoder functions can be read out. The mapping of 
the respective functions is according to the table below. 
 

Bits Definition 

0 Code sequence 

1 Class 4 functionality 

2 G1_XIST1 Preset control 

3 Scaling function  control 

4 Alarm channel control 

5 Compatibility mode 

6...7 Reserved for the Encoder manufacturer 

8…31 Reserved for future use 

Parameter 65001 Sub index 1: Operating status 
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9.14.5 Encoder specific parameter 65003 – Operating status 64-bit structure 
The parameter structure 65003 is a read only structure, where information on the 64-bit 
parameter values can be found. 
 

PNU  65003 

Significance Encoder Operating Status 64 bit 

Data type Array[n] Integer 64 

Access Read 

Validity range Profile specific 

Explanation The status of encoder operating parameters with 64 bit length. 

 
 

Sub index Meaning 

0 Header 

1 Offset value 64 bit 

2 Measuring units per revolution 64 bit  

3 Total measuring range in measuring units  
64 bit

Structure of parameter 65003 "Operating status 64 bit" 
 

9.14.6 I&M functions 
In addition to the PROFIdrive parameter 964, Device Identification, I&M functions are 
supported by the encoder. I&M functions can be accessed with record index 0xAFF0-
0xAFF4. The Leine & Linde encoder supports the following I&M functions.  
 

I&M Parameter Octets Comment 

Header 

Manufacturer specific 10  Not used 

I&M Block 

MANUFACTURER_ID 2 Manufacturer Id, (Leine & Linde = 394) 

ORDER_ID 20 Encoder part number 

SERIAL_NUMBER 16 Encoder serial number  

HARDWARE_REVISION 2 Not used 

SOFTWARE_REVISION 4 Software revision 

REVISION_COUNTER 2 Not used 

PROFILE_ID 2 Encoder Profile number 

PROFILE_SPECIFIC_TYP
E

2 Type of encoder,  

IM_VERSION 2 Version of the I&M profile 

IM_SUPPORTED 2 Value = 0 means support of I&M 

Supported I&M functions 
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10. Firmware upgrade 
The Leine & Linde encoder supports a firmware upgrade function. The firmware upgrade 
function has been developed to offer the possibility to upgrade the encoders in the future. 
For more information regarding the firmware upgrade function, please contact Leine & 

Linde. 
 
Before the upgrade of the encoder can start, the following tools are needed: 

• A  running TFTP server  
• A  WEB browser (Internet Explorer, Firefox, Safari, Opera etc.) 
• DHCP server  

(This is only needed if performing an upgrade outside a PROFINET network) 
 

The encoder itself puts no restrictions on which TFTP/DHCP server to use. The customer 
can choose to use any TFTP/DHCP servers. 
 
There are two different scenarios for software upgrade: 

• Firmware upgrade in a PROFINET network. 
This is when the encoder is connected to a PROFINET network. The encoder will be 
provided with an IP address from the PROFINET IO controller (with DCP).  
 

• Stand alone upgrade. 
This is when the encoder is outside a PROFINET network. A DHCP server is 
required in order to provide the encoder with a valid IP-address. This scenario 
might be valid if the encoder is a spare part or an encoder is removed from a 
system for maintenance. There is currently no support for “bulk upgrades”. I.e. 
each encoder must be accessed and upgraded in turn. 

10.1 Firmware upgrade in a PROFINET network 
The following prerequisites have to be fulfilled in order to upgrade the encoder in a 
PROFINET network: 

• The encoder should be attached to the network. 
• The encoder must have a valid Device name and a valid IP-address (assigned with 

DCP). 
• A TFTP server should be enabled on the LAN where the encoder is attached. See 

chapter 10.4 for an example how to set up a TFTP server. 
 
Once the encoder has been assigned a valid IP-address, it should be accessible on the 
network. Enter the encoder’s IP-address in the WEB browser. 
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When accessing the encoder via the web browser, it will display a number of parameters. 
In the firmware upgrade section of the page, enter the following information: 

• Server IP-address – Enter the IP-address to the TFTP server on the LAN 
• Firmware filename – Enter the full file name of the new firmware file supplied by 

the TFTP server 
• Date – Enter the current date for the upgrade. This is stored as part of the 

“Upgrade History“. The format is yyyy-mm-dd. E.g. 2010-05-15. 
 



PROFINET USER MANUAL                                                                                                                Leine & Linde AB   
 
 
 

  
Part Id: 735795-01 63 
Document Id: 735795 Ver. 02   
Publication date: 2011-06-29 
 

 
 
The parameters are set by clicking the “Submit Values” button. After clicking the “Submit 
Values” button, update the page in the web browser. 
To start the upgrade, click on the “Upgrade” button.  
 
A confirmation page is displayed where the upgrade has to be confirmed before the device 
starts the actual firmware upgrade process. The Continue button must be clicked in order 
to start the upgrade sequence. 
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During upgrade, a “progress page” is displayed. Depending upon the choice of web 
browser, the automatically generated progress page will take some time to be displayed. 
However, the progress web page should always be displayed once the upgrade is finished. 
If no errors occur during upgrade, the encoder will automatically reboot itself and connect 
to the PROFINET IO-controller with the new firmware. 



PROFINET USER MANUAL                                                                                                                Leine & Linde AB   
 
 
 

  
Part Id: 735795-01 65 
Document Id: 735795 Ver. 02   
Publication date: 2011-06-29 
 

 
 
During the upgrade, both the bus status LED and the device status LED will be flashing 
green. If an error occurs, both LEDS will be flashing red. 
 
If the upgrade fails, check the error code displayed on the progress page. The error codes 
are described in chapter 10.3. 

10.2 Stand alone upgrade 
In order to start the stand alone upgrade, the following prerequisites have to be fulfilled: 

• The encoder should be attached to a LAN network  
(See chapter 10.6 LAN configuration). 

• There should be a DHCP enabled server on the LAN where the encoder is attached. 
(See chapter 10.5 DCHP server installation) 

• A TFTP server should be enabled on the LAN where the encoder is attached. 
(See chapter 10.4 TFTP server installation) 

The encoder firmware contains a DHCP client for IP-assignment outside a PROFINET 
network. If no IP-address is assigned by a DCP/PROFINET IO controller, the encoder will try 
to retrieve an IP-address using DHCP.  
 
First start the DHCP and TFTP servers and then power up the encoder. After 
approximately 20-30 seconds, the encoder should have received a valid IP-address. Once 
the encoder has received a valid IP-address, continue with the same upgrade procedure as 
described in chapter 10.1, “Firmware upgrade in a PROFINET network”. 
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It is possible to disable/enable the DHCP client in the encoder. Use the “DHCP 
Enable/Disable” button on the startup web-page in order to toggle between the two modes. 
The encoder will keep this state until the user manually switches state again. 

 
 
Any TFTP server can be used to retrieve file images and any DHCP server can be used to 
assign IP addresses. This manual includes a description of how to install a SolarWinds 
TFTP server (chapter 10.4) and Tiny DHCP (chapter 10.5) from SoftCab on a desktop PC. 

10.3 Error Handling 
This chapter lists all the possible error codes that can occur during an upgrade error. The 
error code will be visible on the “feedback webpage”. If an error occurs, the device will not 
reboot itself automatically. Instead it will wait for user action. This is to allow the user to 
take the next step. E.g. the user might want to check some parameters before rebooting or 
try running the upgrade procedure again. 
 
Failed to download firmware file from server 
Error code: -2 
 
The user should verify the IP-address and the image filename. If any of these is incorrect, 
the user should go back and submit the correct parameters on the main html page 
(index.html). If the parameters are correct, the user should verify that the TFTP server is 
running on the host computer and that the TFTP server settings are correct. 
 
Host not responding/No contact with host computer 
Error code: -3 
 
The user should verify that the host computer is connected to the encoder. The ping 
command can be used for this purpose. If connected, go back to upgrade.html and click 
“Confirm” to try and upgrade again. 
 
Checksum Error/File image error 
Error code: -4 
 
Calculated checksum does not match the one supplied by the image file. The most likely 
cause for this problem is that there was an error when downloading the file to the 
encoder. Go back to upgrade.html and press “Confirm” to try again. 
 
Flash Erase/Write Error 
Error code: -5 
 
The image might be corrupt. Flash Erase or Write failed. If this error occurs, the device can 
still start with its failsafe image. It will be displayed by the “Execution State” parameter on 
the web page. 
 
File Size Error 
Error Code: -6 
 
The firmware file is too big to be written to flash. 
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Insufficient Memory 
Error Code: -7 
 
There is not enough memory available to store the firmware file image. 
 
Invalid Firmware File 
Error Code: -8 
 
Firmware file is not supported for this hardware. 

10.4 TFTP server installation 
The TFTP server used in this example is a freeware TFTP server for Windows NT/XP/Vista 
platforms and can be downloaded from www.solarwinds.com. 
 
Unzip the installation file and double click on the SolarWinds-TFTP-Server.exe file to start 
the installation. Follow the instructions on the screen to complete the installation.  
 
Create a folder on C:\ named TFTP_Root (if it not already exists). Copy or Move the new 
firmware file used to the C:\TFTP_Root directory. 
 
Start the SolarWinds TFTP server and click on the File->Configure tab to open up the 
Configure window. 
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In the Configure window: 
• Make sure that the correct network interface is selected in the “Used NIC” 

selection menu. I.e. it is the network interface which is connected to the encoder 
network. 

• Set up the path to the TFTP root directory. I.e. the TFTP-Root directory created 
under C:\. 

• Leave the other parameters with their default values. 
• Click Start to start the TFTP server service in Windows. 

 

 
 
Note: The server will listen to port 69. Verify that there is no firewall blocking the port for 
incoming/outgoing requests. Temporarily disable any firewall if experiencing 
communication problems. 

10.5 DHCP server installation 
The DHCP server used in this example is a freeware DHCP server for Windows 
NT/XP/Vista platforms and can be downloaded from www.softcab.com. 
 
Note: Before starting the installation, disconnect the PC (where the DHCP server is to be 
installed) from the office network. It can be connected to the network again once the 
server is configured. 
 
Once the DHCP server has been downloaded, double-click on the dhcp.exe file to start the 
installation and follow the instructions on the screen. 
 
After installation, start the Tiny DHCP server program.  
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The “Unknown” physical address is predefined. Select “Drop incoming requests silently” 
for unknown interfaces. 
 
Select “Add new” and enter the MAC address of the device you intend to supply with an IP-
address. The MAC address for the encoder is written on the encoder label. 
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Provide the appropriate settings for the target device. It is important to make sure that the 
IP-address of the encoder is on the same network as the desktop PC. The first three bytes 
of the IP-address needs to be the same on the PC and the encoder.  
If, for example, the PC has an IP-address of 192.168.0.1 and subnet mask 255.255.255.0, the 
IP-address of the encoder can be set as 192.168.0.2 and subnet as 255.255.255.0. 
 
Once the above configuration has been made, the PC can be connected to the office 
network again if necessary.  
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10.6 LAN Configuration 
The picture shows a typical setup in order to upgrade the encoder.  
 

 
 
Consider the connection between the desktop PC and the encoder. The encoder and the 
desktop PC both have to be on the same logical LAN. In order to set the IP-address of the 
desktop PC (windows),go to the “Control Panel” and select “Network Connection”. Right-
click on the network interface connected to the local LAN. Then open the properties for 
the Internet Protocol (TCP/IP). 
 

 
 

Desktop PC with 
TFTP/DHCP server Encoder  

192.168.0.2/ 
255.255.255.0 

192.168.0.1/ 
255.255.255.0 
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Set the appropriate IP-address and Subnet mask for the interface according to the 
example below. 
 

 
 
Use Tiny DHCP server to provide the encoder with a valid IP-address 
(See chapter 10.5). 
 
Note: It is recommended to keep the desktop PC disconnected from the office network to 
avoid interference with the office network. 

11. Encoder replacement using Link Layer Discovery Protocol (LLDP) 
The encoder supports Link Layer Discovery Protocol (LLDP). LLDP is essentially a neighbor 
discovery protocol used by network devices for advertising their identity, capabilities and 
interconnections. 
 
In a PROFINET network, all IO devices are recognized by their device name. 
Sometimes an IO device needs to be replaced in an automation system, and this is when 
LLDP is useful. Using LLDP, the neighbor relations between the individual IO device and 
the IO controller are analyzed and stored on the IO controller. If an IO device has been 
replaced, the IO controller will recognize this and will redefine the device name. 
 
Follow the instruction below to exchange an IO device using LLDP: 
Select the properties of the PN-IO controllers interface module and enable Support device 
replacement without exchangeable medium. 
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Configure the topology of the system for all connected ports. 
 

 
 
 
 



PROFINET USER MANUAL                                                                                                                Leine & Linde AB   
 
 
 

  
Part Id: 735795-01 74 
Document Id: 735795 Ver. 02   
Publication date: 2011-06-29 
 

In the properties window, select the corresponding partner port.  
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Then select Edit-> PROFINET IO->Topology to open the “topology editor”. 
 

 
 

 
 



PROFINET USER MANUAL                                                                                                                Leine & Linde AB   
 
 
 

  
Part Id: 735795-01 76 
Document Id: 735795 Ver. 02   
Publication date: 2011-06-29 
 

Verify that the offline topology matches the online topology. 
 
Once the above has been verified, it is possible to replace any IO device if the ports are 
reconnected in the same way and the new device is set to factory reset. 
 
To manually perform a factory reset for the encoder, follow the steps below: 
 
Select PLC-> Ethernet-> Edit Ethernet Node. 
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Enter the encoder´s MAC-adress and then click on the Reset button. The MAC-adress of 
the encoder is written on the encoder label. 
 

 
 
 
Click “yes” in the confirmation window to reset the encoder to its factory settings. 
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12. Encoder state Machine 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
   
 
 
 
 
 
 
 
 
 
  
 
 
 

Control word 
 bit 14 = 0 

Control word  
bit 14 = 1 

Control word bit 
12 = 1 

Control word bit 
12 = 0

Control word bit 15 = 0 & without 
error 

Control word bit 
14 = 1 

Error 

Sensor control word 
bit 15 = 0 & with error 

Sensor control word 
bit 15 = 1 

 

Error Acknowledgement 
 
 

             Error  
(Error code in G1_XIST2)
 
 

             Parking 
 
 

           Start up 
 

Control word  
bit 15 = 0 & with error 

Control word  
bit 15 = 1 

Status word = 0x8800     
(bit 15 = 1) 
(Bit 11 = 1)                     

 
Status word = 0x8000   
(bit 15 = 1)

 
Status word = 0x4000 
(bit 14  = 1) 

 
Status word = 0x4000 
(bit 14  = 1) 

            Profile 3.x 
 
    Status word 2 = 0x0000 
    (bit 9 = 0) 

                                      Profile 4.x 
 
 
 

Control word
 bit 13 = 1 

       Transmit absolute value cyclically 
       Status word  = 0x2000 
       (bit 13 = 1) 

Data in control word is not valid 

Control word 2
 bit 10 = 1 

Control word 2
 bit 10 = 0 

      Status word 2= 0x0000 
      (bit 9  = 0) 

      Status word 2= 0x0200 
      (bit 9  = 1) 

Data in control word is valid

Normal operation 

                                       Set/shift home position 
 Preset mode absolute 

Status word = 0x1000     
(bit 12 = 1)                      

Preset mode relative 

Status word = 0x1000     
(bit 12 = 1)                     

Control word  
bit 11 = 1 & bit 12 = 1 
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12.1 Normal Operation state 

12.1.1 Profile Version 4.x 
If using encoders complying with encoder profile v4.1, then bit 10 “Control by PLC” in 
Control word 2 needs to be set before the data in Control word is valid. If not set, Control 
word is not used by the encoder firmware. 

12.1.2 Profile Version 3.x 
If using encoders complying with encoder profile 3.x, the data in Control word is always 
valid and bit 9 “Control requested” in Status word 2 is always cleared. 

12.1.3 Profile Version 3.x and 4.x 
When using telegram 81-83 and Control word bit 13 “Request absolute value cyclically” is 
set, then Status word bit 13 “Transmit absolute value cyclically” is set. Status word bit 13 
is cleared (bit 13=0) when Control word bit 13 is cleared. Status word bit 13 is always 
cleared when using telegram 84, due to the fact that no absolute value is sent in G1_XIST2. 

12.2 Parking state 
This state can be reached from any other state. The position value in G1_XIST1, G1_XIST2 
and G1_XIST3 are set to zero. Errors are cleared and alarms are disabled in parking mode.  

12.3 Set/shift home position (Preset) 
The Set/shift home position is initiated when Control word bit 12 “Request set/shift of 
home position” is set. In this case the Status word bit 12 “Set/shift of home position 
executed” is set to 1. In order to initiate a set/shift home position, Class 4 functionality 
must be enabled (see chapter 9.2), otherwise there will be an error in G1_XIST2. 

12.3.1 Preset depending on different telegrams 
When using standard telegram 81-83, the acyclic encoder parameter 65000 “Preset value 
32” bit should be used to set a preset value (<=32 bit) for the encoder. If the acyclic encoder 
parameter 65002 “Preset value 64 bit” is used in this case, an error message will be 
returned. With telegram 81-83, the operating status must be read by encoder parameter 
65001 “Operating status 32 bit”. 
 
With telegram 84, the acyclic encoder parameter 65002 “Preset value 64 bit” should be 
used to set a preset value (<=64 bit) for the encoder. If the acyclic encoder parameter 
65000 “Preset value 32 bit” is used in this case, an error message will be returned. With 
telegram 84, the operating status must be read by encoder parameter 65003 “Operating 
status 64 bit”. 

12.3.2 Absolute preset with negative value 
Preset data sent with acyclic encoder parameter 65000 or 65002 are signed values. The 
relative preset mode uses signed preset values, but with the absolute preset mode no 
preset will be made if a negative preset value (set with encoder parameter 65000 or 65002) 
is used while trying to initiate an absolute preset. 

12.4 Error state 
This state is reached when an error has occurred. The encoder can enter this state from 
both the normal operation state and the set/shift home position state. If an error occurs, 
the Status word bit 15 “Sensor error” is set, and the error code is displayed in G1_XIST2 
instead of the position value.  

12.5 Error acknowledgement 
This state is reached when an error has occurred, and Control word bit 15 “Acknowledging 
a sensor error” has been set. The Status word bit 11 “Requirement of error 
acknowledgment detected” and Status word bit 15 “Sensor error” are set to 1. 
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12.6 Start Up 
This state is only reached when Control word bit 14 “Activate parking sensor” are cleared 
(=0). Once the Control word bit 14 is cleared, it takes about 500ms before the Status word 
bit 14 “Parking sensor active” are set to zero (=0). 
The reason for the delay is that before the encoder goes to normal operation mode, an 
initializing of the encoder is made. 

13. Frequently asked questions FAQ 
 

1. Problem: Preset, parking mode and error reset is not possible. 
Solution The Control By PLC bit in Control Word 2 has to be set to 1 (Profile V4.1). 

 
2. Problem: The preset value is lost if the power supply is switched off. 

Solution: Parameter 971 has to be set to 1 in order to save the preset value into 
non volatile memory. 

14. Revision history 
 

Revision Date Changes 

Rev. 1.0 2010-05-20 First release 

Rev. 1.1 2011-01-01 

Additional information regarding the scaling function with 
respect to G1_XIST 1 preset control. Encoder state Machine 
updated with absolute and relative preset. Additional 
information regarding the GSDML-file added.  

Rev 1.2 2011-06-29 Additional information about the variable table  

 


